Excel Data Bridge *@ -
Bill of Materials Function

Introduction
The Bill Of Materials function includes two separate templates :-

e The Multiline template emulates the New BOM and Amend BOM screens in Sage 200, which allows
you to create or amend a Bill Of Materials

’m‘ Excel Bill Of Materials
Data Bridge

3 Item Seleciion Details Version/Status
ChangeReference _Qualitystandard Revision

1575579 CREATE FL/LARGE-KITCHEN-PK-SW3 | FL/LARGE-KITCHEN-PK-SW3 FL/LARGE-KITCHEN-PK-SW3 | Standard kitchen pack for larger kitehens s BEST 102 FaLsE

AlFields | Alields MoAnalysisCodes | Detads | Components | Operations Full | Operations_FromRegiste

o The Multiline template with version control allows for the same functionality with the addition of
version control. This allows you to have multiple versions of a BOM for the same product.

To create a new BOM start by entering in the data required on the template and click Create

There are multiple sheets within both templates. The first is AllFields this covers all fields from all tabs
normally shown in the BOM screen in Sage 200.

Alternatively, they are also broken down into different sheets such as AllFields_NoaAnalysisCodes, Details,
Components, Operations_Full, Operations_FromRegister etc. Each of these sheets can still be tailored to
only contain the data relevant to you.
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Map Fields

The table below explains the purpose of each of the fields available to the worksheet: -

Status Populated when selecting either the Validate or
Create buttons on the Excel Data Bridge ribbon.

¢ The default status on a successful validation will
be Pending

* The default status on a successful creation will be
Processed

When attempting to post to Sage 200, the status
field should either be cleared, or display a status of
Pending. Any other data entered in this field will
prevent the transaction being created in Sage 200.

Should an error be returned in this cell when
attempting to post, it will appear in red. The error
should be corrected in the worksheet, and the
status field cleared before attempting to post again

URN Populated when Create button is clicked.
If no group ID is given it will default to different for
each line. Further details at end of user guide
HeaderAction Header Action determines what action is being
taken against the Bill of Materials, the options are:
e (Create
e Update
e Delete
e Ignore

The following fields relate to the header section for Creating/Amending BOM screen in Sage 200

The Stock Item Code

The Stock Item Name

The following fields relate to the details tab for Creating/Amending BOM screen in Sage 200

Reference Reference for the BOM

Description Description for the BOM

ChangeReference Change reference for BOM

QualityStandard Quality Standard for BOM

Revision Revision for BOM

OnHold Use TRUE to put on hold or false to not put on hold

Reason If on hold a reason code can be entered

DefaultBuildQuantity Set default build quantity for BOM




Excel Data Bridge
Bill of Materials Function

DefaultCostQuantity
CalculateOverheadsAutomatically
OverheadContribution

UseOnlyiInBOMModule

ComponentAssociationRequired
DateEntered

EnteredBy

EffectiveFrom

EffectiveTo

CompReferencesRequired
ComponentAction

ComponentID
CompSequence
CompCode

CompName
CompQuantity
CompUnitofMeasure
CompType
CompUseCompUseSpecificVersion
CompBOMVersion
Complnstruction
CompScrapPercentage
CompFixedQty
CompeUseOnlylnBOM
CompShowCommentLInes
CompReferencelD

Set default cost quantity for BOM

Use TRUE to turn on FALSE to turn off

If previous field is FALSE the overhead contribution
can be entered

Use TRUE to turn on FALSE to turn off

Use TRUE to turn on FALSE to turn off

Displays the date of BOM creation

Select user BOM is entered by

Set effective from date

Set effective to date

The following fields relate to the components tab for Creating/Amending BOM screen in Sage 200

Use TRUE to turn on FALSE to turn off

Component Action determines what action is being
taken against the component line, the options are:

e C(Create
e Update
e Delete
e Ignore

Should not be changed if amending a component

Set BOM component sequence number

Set component item code

Set component item name

Set component quantity

Set Unit of Measure

Set component type

Use TRUE to turn on FALSE to turn off

If previous field is TRUE set version

Instruction for component

Set component scrap percentage

Use TRUE to turn on FALSE to turn off

Use TRUE to turn on FALSE to turn off

Use TRUE to turn on FALSE to turn off

If component reference required is set to TRUE an
ID will be populated

CompReference Set component reference

CompNotes

OperationAction

Add component notes

The following fields relate to the operations tab for Creating/Amending BOM screen in Sage 200

Operation Action determines what action is being
taken against the operation line, the options are:

e C(Create
e Update
e Delete
e Ignore
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OperationlD Should not be changed if amending an operation. If
creating a new operation enter a unique numeric
value such as 1.

OperationSequence Set BOM operation sequence number

OperationType Operation Types available are:

e New

e Existing

e Comment
OpShowCommentLine Use TRUE to turn on FALSE to turn off
OperationReference Right click >
OperationDescription Set operation description
OperationSubContract Use TRUE to turn on FALSE to turn off
OperationDoNotPrint Use TRUE to turn on FALSE to turn off
OpOverlapQty Set operation overlap quantity
OpOverlapPercentage Set operation overlap percentage
OpShrinkagePercentage Set operation shrinkage percentage
OPRuntimeHours Set operation runtime hours
OpRuntimeMins Set operation runtime minutes
OpRuntimeSecs Set operation runtime seconds
OpQtyPerRun Set operation quantity per run

OpDelayMins Set operation delay minutes

OpDelaySecs Set operation delay seconds

OperationNotes Add operation notes

OPResourceAction Operation Resource Action determines what action
is being taken against the operation resource line,
the options are:

e C(Create
e Update
e Delete
e Ignore

OPResourcelineNo Set the line number of the operation resource

OPResourceStepNo Set the step number of the operation resource

OPResourcePhase Operation resource phases available:
e Setup
e Runtime

e Teardown

OPResourceType Operation resource types available:
e Labour Resource

e Labour Resource Group

e Machine Resource

e Machine Resource Group

e Tool Resource

e Tool Resource Group

OPResourceReference Set operation resource reference

OPResourceDescription Set operation resource description

OpResourcePrimary Use TRUE to select FALSE to deselect
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OPResourceSecondary Use TRUE to select FALSE to deselect

OPResourceRate Set operation resource rate

OPResourceQuantity Set operation resource quantity

OpResourceCostingRateTimeUnit Set operation resource costing rate time unit

OPResourceHours Set operation resource hours

OPResourceMins Set operation resource minutes

OPResourceSecs Set operation resource seconds

OPResourceFixedLength Use TRUE to select FALSE to deselect

OPResourceFixedQuantity Set operation resource fixed quantity

OPResourceManningLevel Set operation resource manning level

OPResourceNotes Enter operation resource notes

OpResourceTimeUnit Set operation resource time unit

OpResourceTimeUQuantity Set operation resource time unit quantity

The following fields relate to the subcontract tab for Creating/Amending BOM screen in Sage 200

OPSubcontractID Should not be changed if amending a subcontract
line
OPSubAction Operation Subcontract Action determines what

action is being taken against the operation
subcontract line, the options are:

e C(Create
e Update
e Delete
e Ignore

OPSubPreferred Set if operation subcontract is preferred

OPSubCode Set operation subcontract code

OPSubOrderRef Set operation subcontract order reference

OpSubleadTime Set operation subcontract lead time

OpSubOrderDetails Set operation subcontract order details

OpSubSaturday Use TRUE to select FALSE to deselect

OPSubSunday Use TRUE to select FALSE to deselect

OPSubCostHeading Set operation subcontract costing heading

OPSubQtyBrkAction Operation Subcontract Quantity Break Action
determines what action is being taken against the
operation subcontract quantity break line, the

options are:
e C(Create
e Update
e Delete
e Ignore
OPSubQtyBrkLineNo Set operation subcontract quantity break line
number
OPSubQtyBrkFrom Set operation subcontract quantity break from
OPSubQtyBrkTo Set operation subcontract quantity break to
OPSubQtyBrkCost Set operation subcontract quantity break cost
OPSubQtyBrkRatePerltem Set operation subcontract quantity break rate per
item
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OPSubQtyBrkHoursOffSite Set operation subcontract quantity break hours off
site.

The following fields relate to the component tab for Creating/Amending BOM screen in Sage 200

OpCompAction Operation Subcontract Component Action
determines what action is being taken against the
operation component line, the options are:

e Create

e Update

e Delete

e Ignore
OpComplineNo Set operation component line number
OPCompCode Set operation component code
OpCompQuantity Set operation component quantity

The following field relates to the notes tab for Creating/Amending BOM screen in Sage 200

Enter notes

The following fields relate to the drawings tab for Creating/Amending BOM screen in Sage 200

DrawingAction Drawing Action determines what action is being
taken against the drawing line, the options are:
e Create
e Update
e Delete
e Ignore
Set drawing line number
DrawingReference Set drawing reference

The following fields relate to the analysis code tab for Creating/Amending BOM screen in Sage 200

Acct Mgr Set account manager

Set buyer




Excel Data Bridge #m -
Bill of Materials Function
How to Download Existing BOMs from Sage 200 into Excel Data Bridge

Filtering

Click the Filter button from the ribbon. The screen appears as follows

ETCDCTEIT ) Tell me what you want to do

~ Fl A P Company:
Q‘j g

o N BE 5o HomestyleSage -

Server | View = Sync  Key Work Create

Confin Aundit DNata  Fields Offlin
ectio| & Download Filter - ] X | Bill of Material

:Ar';d;

Setting a filter uses the same logic as filters in Sage 200: -

FIELD OPERATOR VALUE

For example, add the following filter to download the Sage 200 BOM for FL/LARGE-KITCHEN-PK: -
CODE EQUALS FL/LARGE-KITCHEN-PK

Wildcards can also be used to download BOMs containing certain data. For example, if | wanted to download
all BOMs with the word %KITCHEN% somewhere in the code, | would click the + next to And, then add the
following filter before clicking OK. : -

&3 Download Filter — O et

‘... [Code] Is like YKITCHEN%

Tips — Filters
o Clicking the + next to And allows you to add a condition, or use the Insert or Add keys.
o Clicking the x at the right of a condition allows you to delete it or use the Delete key.
o Clicking And allows you to: -
» Add a condition
» Add a group of conditions
» Change the linking operator on a filter with multiple conditions
» Clear all current conditions (only if any are set)
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Downloading Data from the Filter

Once the filter has been set, click BOM Download on the ribbon bar. A new screen will appear with the filtered
BOMs you require. Select the items you wish to be downloaded by ticking on the left-hand side and click download.

@ Download - o ES
Downlcsd | | Selectall | Deselectil | Concel

B GoeEyD | Code Hame Reference | Desapton  ChangeRe... QualiySta... Revison  Onkod | Versen Verson Sta... Checked Out | Checked 0., Component... Date Enfered Date Enler... |Effectve ... EffectveTo  Use Onlyl... DefoultBul... DefaultCa...  Calaate 0. MarkUpPe... Overhead... Mo
W isimsz AMITOHE.. Standads... FLKITCHE.. S

.. Standsrd k... FLAARGE-.. St
Standard k.. FLAMALL-

[F] FALSE (%) acTIE FALSE RUE oyt FALSE 1 1 TRE [
LEN FALSE 0.1 AcTvE FALSE E Uz FALSE 1 1 RE [l

o.m FALSE 0.2 AcTivE FALSE TRUE o119 FALSE 1 1 TRUE 1 0 i
P
I

When downloading data from Sage 200, any existing data in the template will be overwritten in the
worksheet. A message appears confirming this to give the opportunity of saving the file before the data is
downloaded.

Data Import

The downloaded data will overwrite the current sheet, Continue?

Clicking Yes, will download all data from Sage 200 that matches the filter request.

NOTE - if several rows are downloaded into Excel Data Bridge for one BOM In this example each line is
assigned a unique value in the GroupByID / Component ID / CompReferencelD / OperationID columns.

Group by ID / Component ID / CompReferencelD / OperationID from downloaded BOM'’s

When a BOM has been downloaded from Sage 200 please retain the ID’s provided and ensure any new lines
have the Group by ID number provided from the download. This will help ensure that all BOM lines are
correctly organised and grouped together based on the Group ID provided in the download.

IMPORTANT When creating 1 new component line and we suggest you use the value ‘1’ in Component ID.
For multiple line use 1,2, 3 etc. Failure to do this will result in the line being missed.

UPDATE 1513613 n PANEL/
UPDATE 1513614 2 PANEL/
UPDATE 1513615 £ PA/SHE
UPDATE 1513616 ¢! PANEL/
UPDATE 513617 % PA/SHE
UPDATE 1513618 i DOCR/
UPDATE "1513619 7 PANEL/
UPDATE 1513620 (! PANEL/
UPDATE 1513621 % DOCR/
JUPDATE 513622 "0 PK/BUE
UPDATE 1513623 11 PK/CAF
UPDATE 1513624 M2 PK/DOI
UPDATE 1513625 13 IR/LARC
UPDATE 1513626 s PM/SIN
r r
UPDATE 1586286 17 ABBuili
r
CREATE 1 2 ABCool
r
CREATE 2 pE] ABCool

r
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Group by ID

X3

When creating multiple BOMs to Sage 200 at once, Excel Data Bridge needs to inform Sage 200 which lines

belong together.

Any unique data can be entered to keep any ID lines together, such as using numbers 1, 2, 3, 4 or letters a, b,

c, d.

IMPORTANT When creating additional new lines on an existing downloaded BOM ensure the Group by ID has
the same number as per the download.

Excel Data Bridge Browse

There are various columns can search your Sage 200 data directly from the Excel Data Bridge function. Right
click within the column, select Excel Data Bridge Browse and the Browser search will appear. Select 1 or
multiple items and the click Submit to bring them through to the sheet.

a6 Cut
"By Copy
&D Paste Options:
il
q O
< Paste Special...
IE ,{D Smart Lookup
C
5
" Insert
5
3f Delete
JE Select
Al Clear Contents
\L /&l Quick Analysis
E-
I Sort
F Filter
Fl Table
P XML

+
" 1 Insert Comment

Format Cells...

¥ Pick From Drop-down List...

Excel Data Bridge Browse

OOOOOOoOoooOod

AR Freestanding El...

— O ot
Select All Deselect All Cancel [] Insert Rows
Code Marme Free Stock
ABBuiltIn/15/0/2 AB Built-In Cookers... 73
ABBuiltIn/15/1/2 AB Built-In Cookers... 51
N ABBLtin/15/20/2  AB Built-In Cookers... 31
ABBuiltIn/15/21/2 AB Built-In Cookers.., 43
ABBuiltIn/16/0/2 AB Built-In Cookers.., 12
ABBuiltIn/16/1/2 AB Built-In Cookers... 40
ABBuiltIn/16/20/2 AB Built-In Cookers... ]
ABBuiltIn/16/21/2 AB Built-In Cookers... 41
ABCookHoods 222  AE Cooker Hoods C... 13
ABCookHoods/23/2  AB Cooker Hoods 5., 24
ABFSEf12/0/2 AB Freestanding El... 40
ABFSEf12/1/2 AB Freestanding El... 35
ABFSEf12/20/2 AB Freestanding El... 36
ABFSEf12/21/2 AB Freestanding El... 40
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Action Indicators

The action indicator states what action you wish to carry out.

o Create —Creates a BOM line in Sage 200

e Update — Updates existing BOM line in Sage 200
Ignore — Any changes will be ignored.
Delete — Deletes BOM line from Sage 200

IMPORTANT When creating 1 new component line and we suggest you use the value ‘1’ in Component ID.
For multiple line use 1,2, 3 etc. Failure to do this will result in the line being missed.

ComponentAction  ComponentlD CompSequence Comp
UPDATE M1513613 ¢1 PANEd
UPDATE f513614 H PANE
UPDATE M1513615 £ PA/SHE
UPDATE 513616 2 PANEL/
UPDATE f1513617 5 PA/SHE
UPDATE 513618 (4 DOOR/
UPDATE M1513619 7 PANE
UPDATE 513620 3 PANEth
UPDATE f1513621 5 DOOR/
UPDATE 513622 "0 PK/BUE
UPDATE M1513623 1 PK/CAF
UPDATE 513624 2 PK/DO
UPDATE "1513625 "3 mﬂ_.a.n]
UPDATE 513626 s PM/SIN
F F
UPDATE 1586286 17 ABBuil{
F
CREATE 1 22 ABCool
F
CREATE 2 23 ABCool

How to send completed / amended BOMs to Sage

Once you have entered your BOM information, you will need to send the data to Sage, to make your
changes. The status bar will give one of two responses.
e Processed — Data was submitted to Sage 200 successfully.
e ERROR - If validation is unsuccessful, an error will be returned in red. This error must be
rectified, and the error cleared from the status field before submitting the data again.

10
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Amending Templates

The worksheet templates have been created in an Excel table with the correct formatting applied.

Goods Value Tax Value Gross Value

To add additional rows, firstly locate the cell at the bottom
right hand corner of the formatted table.

Goods Value Tax Value Gross Value

Now select the cell then click and drag down on the arrow.

fr— Extra rows will be added with the correct formatting.
% g
=
O
To add additional columns, right click on the Paste Special.. w0 1200
column heading where you would like your new D Smart Lockup o 2400
column to appear and select. Insert>Table = =
Columns to the left. Insert ¥ B Table Columns to the Left
Delete 3

A new column will be added, named Column 1. Rename the column in Excel, then refer to the next section
on how to map this column in designer.

(o) » |

Line Date

11
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Mapping New Columns

To add a column right click on an existing column on the template. Select Insert > Column to the left

% Cut
By Copy
%, Paste Options:

’y

}
DPREsour(EDE D OPResoul§
v i

Paste Special...
1}

O Smart Lookup \

Insert 3
Delete 3
Select »
Clear Contents

A Quick Analysis
Sort >

Once a new column has been added to the template, it can be mapped to the required Sage 200 field.

Click Designer to open the mappings for the template and to locate the field to map the column to.

O % ferver
onfig

@ Map Fields

=t | E

Wersion

ode
LineNo

(OperationComponentQuantity te
P4

Download

OpRescurcefction
OpRescurceDescription
OpResourceExporiToGraphicalPlan
OpResourceFixedLength
OpR FixedQuantity F
OpResourcelineMo OpR LineNo

Click the [+ elipsis to the right of the field. The cell mapping window will appear.

Select the cell range for the column before clicking OK.

The column is now mapped and can be populated in Excel Data Bridge.

12
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Deleting Unwanted Columns

To delete an unwanted column in a template complete the following steps.

Remove the field mapping from the designer. To do this open the designer to view the mapping.

gn = — . S N > NP st o0 et
@& Map Fields o ox [eer W
onfig  Au
=t |8 Au
“ersion ~
DperationC: ineho -
DperationCompenentQuantity te r I a
Dawnload P4
OpResourceliction
OpR: Description
OpResourceExporiToGraphical Plan|
OpResourceFixedlLength OpResourceFixedLength
OpResourceFixedQuantity OpR: dQuantity
OpResourcelineNs OpRi LineNo
OpR: evel OpR inglevel
OpResourceMotes OpRi
OpResourcePhase OpResourcePhase Ilte
OpResourcePrimary OpResourcePrimary
DpR: Cuantity OpResourceQuantity
OpResourceRate OpResourceRate OpResourceReference OpResourceReference rL
OpResourceRaieCosiRateFornit_| OpResourceRateCost RateForUnit OpfRescurceResourceType OpResourceResource Type
DpResourceRateTimelnit OpResourceRate Time Unit OpR v R Y
OpResourceReference OpResourceReference FL/ OpResourceStephla R
DpResourceResourceType OpResourceResource Type OpResourceTimeDetails_Hours  [€3]37 TimeDetails_Hours |...|
OcR Oph: - OpResourceTimeDetails_Mins OpRi TimeDetails_Mins
OpResourceStepNo OpResourceTimeDetails_Secs R TimeDetails_Secs
OpResource TimeDetails_Hours |...| ‘OpResourceTimelnitDetails_Quani| OpR TimeUnit Details_Quant
OpR TimeDetails Mins OpResourceTimeUnitDetails_Timel OpResource Time Unit Details_Timell
OpRi TimeDetails_Secs
OpResourceTimelnitDetails_Quani OpRe Time Unit Details_Quant
OpResourceTimeUnitDetzils_Timel| OpResource Time Unit Details_Timel

Clear the data in mapping field. Close the designer then click Validate Design to check for errors.

Lastly remove the column from the template. Right click the column heading and select Delete>Table
Columns.

CB ce cD
&% Cut
B3 Copy
ry Paste Options:
.

0

Paste Special...

Insert
Delete

Clear Contents

Time Details Format Cells...

esourceCostRateUnit Column Width...

Hide

Unhide
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